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See Academic Standing (SHAINST, 
SHATERM, SGASTDQ) 
There are three different ways of seeing a student’s academic standing in Banner 
Admin.  The first is the academic standing as of the end of a specific term.  The 
second is the current academic standing, and the last is via a snapshot of all terms 
the student has been enrolled.  Regardless of the particular view of academic 
standing, the codes you will see will be the same.  Those codes are listed below, 
with their meanings. 

WARNING:  Information that is found on SHAINST, SHATERM, and SGASTDQ is 
highly sensitive information and should be treated with the utmost confidentiality 
as per Auburn University Policy. 

Academic Standing Codes 
00 Default 

1P Appeal – 1st Suspension 

1S 1st Acad Suspension 

2P Appeal – 2nd  Suspension 

2S 2nd Acad Suspension 

AE Academic Dismissal 

AP Appeal – Dismissal 

AW Academic Warning 

CW Continued Warning 

G1 Good Standing 

G2 Good Standing 

G3 Good Standing 

GR Graduate 

LW Last Warning 

PR Professional 

RE Good Standing - Release 

 

See Academic Standing – End of Term 
1. Enter “SHAINST” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName and term code in the appropriate fields. 
3. “Next Block” into the “Term Header” block of the form. 

 



2 Look Up Information 

The Academic standing is listed in the “End of Term Academic Standing field.  Note 
that this academic standing is for the end of the term that was entered in the 
“Term” field of the key block. 

See Academic Standing – Current 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field.   
3. Enter the appropriate “Course Level” code in the “Course Level Codes by 

Person” field.  Use the drop down list if you need to see the available 
codes for a particular student. 

4. Leave the “Start Term” field blank. 
5. “Next Block” into the “Current Standing” Block of the form. 

 

The academic standing is listed in the “Academic Standing” field.   

See Academic Standing – Snapshot (End of Terms 
1. Enter “SGASTDQ” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “Student Summary” field of the form. 
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The academic standing snapshot for each term is located in the “Academic 
Standing --- Code” field.  Note that the academic standing code has the effective 
term listed immediately to the right of it on the form.  This is the academic 
standing as of the end of the effective term listed. 

The “Override” “Code” and “Term” fields are located immediately to the right of 
the populated “Code” and “Term” fields.  These fields are used to indicate when 
a student has had an override to his or her academic standing.  The most 
common reason for this to occur is when a student is suspended.   

When a student is suspended, the “Academic Standing” code will be 1S (or 2S if 
appropriate) with the effective term listed to the right.  In order for that student 
to be able to resume studies at Auburn, that academic standing must be 
appealed.  If a student does not appeal the suspension, that student will 
prevented from registering for courses during the next registration period.   

Therefore, the 1S academic standing code will be “Overridden” to AW or other 
appropriate code.  This will permit the student to register during the next 
registration period.  When the override is entered, the effective term for the 
override is also entered. 

See the Assigned Instructor for Class(es) 
There are two ways to see the assigned instructor for classes.  The first requires 
access to Banner Admin, the second uses information that’s been made publically 
available to all members of the Auburn Community. 

See Assigned Instructor (Banner Admin) 
Most general information about individual classes is stored on the SSASECT form 
in Banner Admin.  To see the assigned instructor: 

1. Enter “SSASECT” in the “Go To…” field of the main menu in Banner 
Admin, then strike the <enter> key. 

2. Enter the appropriate term code in the “Term” field. 
3. <TAB> to the “CRN” field, then enter the appropriate CRN for the desired 

class section. 

 
4. “Next Block” until you are in the “instructor” block. 
5. The assigned instructor and his/her Banner ID number will be 

displayed.  Multiple instructors may also be displayed if appropriate to 
that class section.  Note:  If no instructor has been assigned (the 
instructor block is blank), “TBA” will be printed in the public access view 
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of the assigned instructor. 

 

See Assigned Instructor (Public Access) 
1. From the AU Homepage, log in to AU Access. 
2. Click on the “Employee Services” tab. 
3. Scroll down to the “Quick Links” channel. 
4. Click on the “Schedule of Courses” link. 
5. Select the appropriate term from the “Term” dropdown menu list, then 

click the “Submit” button. 

 
6. Select at least one subject.  You can select multiple subjects by either 

<shift>+clicking (continuous list) or <ctrl>+clicking (discontinuous list). 
7. If you want a single course, enter the course number in the “Course” 

field.  Otherwise, leave “Course” blank for all classes within a particular 
subject area. 

8. Click the “Class Search” button. 

 
9. The results are listed by Subject, then course number, then in CRN 

order.  Assigned instructors may be seen by scrolling to the right and 
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looking under the “Instructor” column.  Note:  “TBA” will be printed for 
those classes that do not have an assigned instructor. 

 

See The Registration Audit Trail 
(SFASTCA) 
To see the registration audit trail in Banner Admin: 

1. Enter “SFASTCA” in the “Go To…” field of the main menu in Banner 
Admin. 

 
2. Enter the appropriate term code in the “Term” field. 
3. <tab> to the “ID” field and enter the appropriate student username.  You 

may use either the AU username or the Banner 902 number. 

 
4. “Next Block” into the body of the form. 
5. The registration activity for that student will be displayed.  Multiple 

transactions can be viewed by using the scroll bar at the right side of the 
screen. 
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SFASTCA is a searchable form.  That means that users can enter a new query 
(using F7 on the keyboard or the “new query” button, or “Query, New” from the 
menu) to locate activities that are specific to a particular course, date, user, etc.  
Any of the fields are able to be used as searching parameters. 

Interpreting the Audit Trail 
There are several pieces of information that are displayed on the registration audit 
trail.  Refer to the illustration below for the location of field names that are 
explained. Some fields may have different information displayed for you than 
appears in this illustration.  Where possible, the various values are provided for 
your reference.  Questions relating to specific information that is displayed to users 
should be directed to the Registrar’s Office  

 

Sequence Number 

The order in which Banner attempted to complete the transaction 

Term 

The term code for the term in which the transaction took place 

CRN 

The CRN for the course the transaction covers 

Subject 

The 4 letter code of the class the transaction covers (ie. ENGL = English) 

Course 

The course number of the class the transaction covers 

Section 

The 3 character code for the specific section the transaction covers 

Level 

The level for which the student is enrolled in the section covered by the 
transaction. 
UG = Undergraduate 
GR = Graduate 
PR = Professional (ie. Nursing, Vet School, Pharmacy) 
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Grading Mode 

The type of grade that is attached to that student in that particular course covered 
by the transaction. 
S = Standard Letter Grades 

P = Satisfactory/Unsatisfactory (Pass/Fail) 

A = Audit 

T = Thesis/Dissertation 

N = Non-graded (ie. Many labs in the sciences have “N” grade types) 

Attempted Hours 

The Count in Attempted Hours checkbox is used to indicate if the credit hours in a 
course to which the grade has been assigned should be added to the student's 
hours attempted.  When checked ('Y'), the hours will count in attempted hours. 
 When unchecked ('N'), the hours will not count in attempted hours. 

Credit Hours 

The number of hours the student will receive for the course. 

Bill Hours 

The number of hours the student will be charged for the course. 

Source 

The source of the information from within Banner. 
TEMP = Temp table.  This location is where data is stored while Banner works to 
resolve registration issues.  Information from the TEMP table does not get stored 
permanently on a student’s schedule, but is still visible in the audit trail.  TEMP 
table information indicates that an attempt has been made to accomplish some 
task (ie. Registration, dropping, etc.). 
BASE = Base table.  This is the permanent location for information in Banner that 
relates to a student’s schedule.  BASE table information indicates that a 
transaction has been successfully completed (ie. Registration, dropping, etc.) 

Course Status 

The registration status for the course as it relates to the student’s schedule. 

RE = Registered via Banner Admin  

RW = Registered via the Web (this is what will be listed when students successfully 
register for a class.) 

DD = Drop/Delete 

DW = Dropped via the Web (this is what will be listed when students successfully 
drop a class) 

Status Date 

The date that the registration status was assigned. 
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Add Date 

The date the class was added to the student’s schedule.  Also the first date that the 
transaction occurred. 

Message 

Information regarding possible errors that may be associated with that transaction.   

“Class Restriction” = Usually indicates that the class is limited only to students in 
a certain classification (Juniors and above, for example). 

“College Restriction” = Usually indicates that the class is restricted to student 
enrolled in a particular college (College of Business students only, for example). 

“CORQ_XXX### Error” = Co requisite error.  Banner enforces co-requisites that 
have built from the catalog.  Banner expects the student to register for classes that 
are co-requisites at the same time.   

“Degree Restriction” = Usually means that the class is limited to students enrolled 
for a particular degree (this restriction is likely not used very often at Auburn). 

“Duplicate Course Section Error” = The student or someone else attempted to 
register for two sections of the same class.  Banner prevents this.  Students 
enrolling in special topics courses have had this error frequently.  Most of the 
causes have been corrected, however. 

“Level Restriction” = Usually indicates that an undergraduate student attempted to 
register for a professional or graduate level course. 

“Major Restriction” = The student does not have the correct major attached to their 
record in order to be eligible for enrollment in this class. 

Prereq & Test Score Error” = The student is missing a pre requisite or test score 
that is required prior to enrollment in this course.  

“Program Restriction” = The student does not have the proper program code 
attached to their record to be eligible for enrollment in this course. 

“Repeat Hours Restriction” = The student attempted to register for too many hours 
of this course (This may not be an error that is encountered very often at Auburn). 

“Repeat Limit Restriction” = the student attempted to register too many times for 
this course (this may not be an error that is encountered very often at Auburn). 

“Special Approval Required” = This course requires some sort of special approval.  
Usually this is department level or instructor approval. 

“Time Conflict_##### Error” = The student’s schedule has a class that conflicts 
with the class being requested from Banner.  This will happen most often when a 
student attempts to register for a class that begins at the same minute of the day 
as another class ends (ie. Conflict = Class A ends at 3:00 pm; Class B begins at 
3:00 pm.) 

“Reserve Closed” = The limit for the reserved seats for students who meet the level 
(UG, GR, PR, etc.), Major, or Class (FR, SO, JR, SR, etc.) has been reached.   
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User 

The user who initiated the transaction in Banner. 

AU formatted usernames (ie. WOLFSA1) indicate that a person with Banner Admin 
access initiated the transaction. 

WWW2_USER = the student initiated the transaction via the Web. 

Activity Date 

The last date that activity took place on that transaction. 

Error Flag 

Whether an error was given to the student or user attempting to initiate the 
transaction.   

F = An error message was given to the user 

O = An override was given in response to an error message. 

W = An error warning was given to the student or user, but registration was not 
blocked. 

D = the class was dropped from the student’s schedule 

See Class Roster(s) (SFASLST, Toolkit) 
There are three ways for a class roster to be accessed.  The first is through Banner 
Admin, the second is via the Blackboard (WebCT) Toolkit, and the third is via 
Banner Self-Service (for instructors of record only). 

WARNING:  Information that is found on SFASLST as well as roster information is 
highly sensitive information and should be treated with the utmost confidentiality 
as per Auburn University Policy. 

See Class Roster (Banner Admin) 
1. Enter “SFASLST” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the appropriate term code and CRN in the corresponding fields. 

 
3. “Next Block” into the form. 
4. The class roster is displayed (6 names per screen).  The full roster can be 

viewed by scrolling through the list.  Note:  The “sequence” field displays 
the order in which the corresponding student was enrolled in the course.  
Gaps in the sequence indicate that that particular student dropped the 
course.  So, a course may have a limit of 25 students, but have students 
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with 26, or 27 showing in the “Sequence” field.  This indicates that 2 
students registered for, then dropped the course.  See the starred entries 
on the illustration below for an example.  Notice that whomever was 
registered 5th for this class dropped the class.  That Sequence number is 
not reused. 

 
WARNING:  Notice that midterm and final grade columns are on these 
results.  Grades are highly sensitive information and should be treated 
with the utmost confidentiality as per Auburn University Policy. 

See Class Roster (Blackboard/WebCT Toolkit) 
1. From the AU Homepage, click on “Employees.” 
2. Click on the “Blackboard (or WebCT) Toolkit” link. 
3. Log in with your regular username and password. 
4. Click on the “Class rolls/email” link. 
5. Select the appropriate term, department/interest area; course number, 

section, call number and/or instructor information, then click the 
“Search” button. 

6. Highlight the specific class that is desired, then click the “View Class 
Roll” button.  Note: You can also elect to send the entire class an email 
from this screen.  Emails sent from this tool will be delivered to the 
students’ TigerMail address(es). 

See Class Roster (Banner Self-Service:  Instructors of 
Record Only) 

1. From the AU Homepage, click on the “Employees” tab. 
2. Click on the “AU Access” link. 
3. Log in with your regular username and password. 
4. Click on the “Employee Services” tab. 
5. Click on the “Banner Self-Service” icon/link. 
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6. Click on the “Faculty Services” tab. 

 
7. Click on the “Summary Class List” link (or “Detail Class List” link). 

  
8. Select the appropriate term, then click the “Submit” button. 

 
9. Select the appropriate class from the CRN dropdown menu, then click 

the “Submit” button.  Note:  Class titles are supplied in the dropdown 
menu for your convenience. 

 
10. The roster of that class will be displayed.  Note:  Envelope icons at the 

end of each student’s entry indicate a link to that student’s email.  You 
may elect to send individual students email using this tool.  If you 
selected “Detail Class List” you will see both a “Record Number” and a 
“Registration Number.”  The “Record Number” is the place that student 
occupies in the alphabetical listing of all students enrolled in that 
course.  The “Registration Number” is the order in which the student was 
enrolled in the course (the first person to enroll will have “1” as the 
Registration Number, even if they have 23 as the “Record Number” for 
their last name beginning with Y or Z). 
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See Contact Information (SOADDRQ, 
SPATELE, GOAEMAL, SPAEMRG) 
WARNING:  Information that is found on SOADDRQ, SPATELE, GOAEMAL and 
SPAEMRG is highly sensitive information and should be treated with the utmost 
confidentiality as per Auburn University Policy. 

There are many codes that are used to describe the type of address associated with 
a person in Banner.  However, only a few are routinely applied to student records.  
Those codes are listed below. 

LO Local 

MA Mailing 

N1 & N2 Next of Kin(s) 

PR permanent 
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See Contact Information: Address(es) 
1. Enter “SOADDRQ” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the body of the form. 

 

See Contact Information: Phone Number(s) 
1. Enter “SPATELE” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “Telephone” tab of the form. 

 

See Contact Information: Email address(es) 
1. Enter “GOAEMAL” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
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3. “Next Block” into the “Email” tab of the form. 

 

See Contact Information: Emergency Contacts 
1. Enter “SPAEMRG” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “”Emergency Contact” tab of the form. 

 
Note:  The information on this form is self-supplied by students and 
employees via self-service.  If this form is blank, the user did not provide 
the information.   

See Curriculum Designation (SGASTDN) 
Only the office of the registrar has the authority to view or run official student 
transcripts.  However, advisors may need to see a list of courses taken, with 
grades, in order to provide accurate guidance to students.  That information is 
available in Banner Admin on the SHATERM form. 
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WARNING:  Information that is found on SHATERM is highly sensitive information 
and should be treated with the utmost confidentiality as per Auburn University 
Policy. 

See Curriculum Designation 
1. Enter “SGASTDN” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. Leave the “Term” field blank to have information related to all enrolled 

terms for that student available to you. 
4. “Next Block” into the desired tab of the form. 

Learner Tab  

Term related information is presented with the most current term displaying first.  
Past terms can be viewed by using the scroll bar (if activated) or the down arrow 
key on the keyboard.  The students program code is listed in the “Program” field of 
the “Curricula Summary – Primary” block fo the form.  The student’s major is listed 
in the “Field of Study” field of the “Field of Study Summary” block of the form. 

 
Note:  the scroll bar on the right side of the “Curricula Summary” block of the form 
will be activated if the student has a double-major.  If this is the case, you will 
need to use the scroll bar to see which major is listed as the second one of the 
double-major. 

Curricula Tab (Curriculum) 

Detailed information about the student’s curriculum is presented, with the option 
of viewing various terms via the “Record” field.  By using the right and left pointing 
arrows in the “Record” field, you can see the curricula that were assigned to the 
student for various terms.   
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Curricula Tab (Field of Study) 

Detailed information about the student’s field of study is presented on th “Field of 
Study” tab of the “Curricula” tab.  The students 4-letter “major” is listed in the 
“Field of Study” field.  As with the Curricula tab, you can scroll through various 
terms to see the majors that might have been attached to a student throughout his 
or her attendance at Auburn. 

 

Academic and Graduation Status, Dual Degree Tab 

Detailed information about the student’s academic status and graduation status 
are presented on the “Academic and Graduation, Dual Degree” tab.   
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See Class(es) Enrollment (Counts) 
(SSASECT) 

See Enrollment Counts (Banner Admin Option 1) 
Most general information about individual classes is stored on the SSASECT form 
in Banner Admin.  To see the enrollment counts for a specific class: 

6. Enter “SSASECT” in the “Go To…” field of the main menu in Banner 
Admin, then strike the <enter> key. 

7. Enter the appropriate term code in the “Term” field. 
8. <TAB> to the “CRN” field, then enter the appropriate CRN for the desired 

class section. 

 
9. “Next Block” until you are in the “section details” block. 
10. Select “Section Enrollment Info” from the “Options” menu.  Enrollment 

counts are displayed in the “Enrollment Details” block.  Note that the 
limit is listed as the “Maximum” and the other numbers indicate how 
many students are enrolled in the course (actual) and how many empty 
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seats remain in the course (Remaining).   

 

See Enrollment counts (Banner Admin Option 2) 
1. Enter “SSASECQ” in the “Go To…” field of the main menu in Banner 

Admin. 

 
2. Enter the desired query information, then “Execute” the query. 

 
In this example, the query will return any section of EDMD 3300 from 
the 200810 term (Fall, 2007). 

3. General information is displayed.  Multiple sections that meet the search 
criteria can be accessed by using the scroll bar at the right side of the 
screen. 

 

See Enrollment Counts (Public Access) 
10. From the AU Homepage, log in to AU Access. 
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11. Click on the “Employee Services” tab. 
12. Scroll down to the “Quick Links” channel. 
13. Click on the “Schedule of Courses” link. 
14. Select the appropriate term from the “Term” dropdown menu list, then 

click the “Submit” button. 

 
15. Select at least one subject.  You can select multiple subjects by either 

<shift>+clicking (continuous list) or <ctrl>+clicking (discontinuous list). 
16. If you want a single course, enter the course number in the “Course” 

field.  Otherwise, leave “Course” blank for all classes within a particular 
subject area. 

17. Click the “Class Search” button. 

 
18. The results are listed by Subject, then course number, then in CRN 

order.  Enrollment information is listed immediately to the right of the 
meeting time information.  Cap = Capacity/Maximum; Act= Actual 
number of enrolled students; Rem = Remaining open seats. 
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Notes: 1: this class has 3 open seats;  2:  This class is closed;  3:  This 
class is closed, and is “over enrolled” with more students enrolled than 
are permitted by the capacity. 

Find A Person 
If you need to find the username or 902 number for a specific person, but that 
person has a very common name (such as “Smith”) you can perform a “person 
search” from any “ID” field in Banner INB (Banner Admin): 

 
In order to perform a person search: 

1. Click the “search” button next to the “ID” field in any form.   

 
2. Click the “Person Search” link.   

 
3. <TAB> to the “Last Name” field and type the last name.  Be sure to use 

proper capitalization.  You can perform the search at this point, but if 
the name is very common, such as “Smith,” you’ll want to also <tab> 
to the First Name field and enter the first name as well.  Remember 
that you can also use the “%” character as a wildcard.  So, if you’re 
looking for Talitha  Smith (as in the illustration below), you would 
enter “Smith” in the “Last Name” field, and “T%” in the “First Name” 
field.   
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4. When you’re ready for Banner to go look for the person, “Execute” the 
query.  (Use the menu, keyboard, or button option for your 
navigational choice). 

Menu: “Query, Execute” Keyboard: F8 Button:  
5. The illustration below shows the results of the query of “Smith, T%”.   

 
Note that the Last and First names, the middle initial and the birth 
date are all identical for the two records for Talitha.  Also note that 
the “Change Indicator” field for the record that contains the 902 
number in the “ID” field is blank.  This means that that is the original 
record for Talitha.  Talitha’s username is “SMITHTS,” you can use her 
username or her 902 number to access her records. 

Finding Persons: SOAIDNS 
Sometimes it is difficult to tell the difference between all potential matches to a 
search of “John Smith.”  The use of the student’s major or program can provide 
valuable additional information to aid Banner users in selecting the proper name. 

1. Enter “SOAIDNS” in the "Go To..." field of the main menu in Banner 
Admin, then strike the <ENTER> key. 

 
2. Enter the desired information in the search fields provided.  Be sure to 

use capital letters when entering name information.  The use of the 
Banner Wildcard symbol (%) will yield a larger list of results.  Note:  Only 
the highlighted fields are available for use in searching for persons on 
this form. 
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3. “Execute” the query by using either the keyboard (F8), menu (Query, 
Execute), or toolbar button options.  

4. Use the information provided in the results lists to select the proper 902 
number for the desired person as you need. 

 
 
Key: 
1) Banner Number and name information. 
2) Birthdate information 
3) Active scroll bars that indicate longer lists of information available 
4) Address(es).  Be aware that addresses are considered sensitive 
information and should not be shared with unauthorized people. 
5) Curricula information:  major, program, etc. 

Finding Persons: Important Notes 
The ability to search for and find a person is directly related to the accuracy of the 
information that has been entered into Banner.  Therefore, it is important to be 
persistent when searching for persons in Banner, as the name may have simply 
been entered differently than your search strategy. 

For example: 

• Spacing and common misspelling issues in names (i.e., Mc Donald vs. 
McDonald vs. MacDonald, etc.)  

• First name and middle name in same field (this is especially true for 
names that have unfamiliar formats, such as some for international 
students)  

• Inversion of first and last name in fields (Blake Edwards vs. Edwards 
Blake) 

• Addition of suffix on last name (Bill Smith Jr – where the “Jr” is included 
as a part of the last name, instead of in a separate field when his 
information was first entered into Banner). 
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It is also important to remember that the wildcard symbol (%) can be used 
anywhere in a search string.  Some acceptable examples of search strings using 
the wildcard in a variety of positions are: 

• Search string:  Wit%  J% (Last Name, First Name) 
Returns include: Joseph Wit, James Witte, Jennifer Witten 

• Search String: S%h  A% (Last Name, First Name) 
Returns include:  Adam Scarborough, Ankur Shah, Adam Smith 

• Search String %al % (Last Name, First Name) 
Returns include:  Jules Ackal, Ablani Al, Trevor Bal 

See GPAs (SOAHSCH, SHATERM, 
SHASUBJ, CAPP, SZFSHTM) 
There are several different ways of seeing a GPA in Banner Admin.  The most 
important distinction to understand is that GPA is calculated “live” in Banner.  
Therefore, an UNGAPPED GPA is not viewable in Banner Self-Service nor in Banner 
Admin.  Ungapped GPA information must be acquired from a report that is written 
outside of Banner.  

The following viewing options are available for GPAs.  Transfer, Gapped (Auburn 
Only), Within Major/Program, All Auburn, Overall, by Subject Area, from the High 
School (if this information was entered during the admissions processing 
procedures and lastly Ungapped cumulative GPA.   

WARNING:  Information that is found on SOAHSCH, SHATERM, SHASUBJ, 
SZFSHTM and CAPP is highly sensitive information and should be treated with the 
utmost confidentiality as per Auburn University Policy. 

See GPA: Transfer Work 
4. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
5. “Next Block” into the “Current Standing” block of the form. 
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The transfer GPA is listed in the middle line at the bottom of the block.  Note that 
the transfer GPA will only be accurate if the transfer work has been posted 
correctly.  Questions about listed “earned hours” in the transfer line should be 
directed to the admissions person appropriate for the student (Graduate School or 
Admissions office). 

It is important to note that the GPA listed on SHATERM is the most recently 
calculated GPA.  That means that during certain times in the semester such as 
when grades are being submitted and rolled to academic history, this GPA may 
change on a day to day basis.  There may be instances as well, when the GPA will 
seem to change “overnight,” especially when students have had “IN” grades cleared.  
Whenever a grade is rolled to academic history, the GPA fields are updated to 
reflect the current GPA.   

Students may find this confusing at first, especially when the first semester’s 
grades are entered by faculty.  Students should not assume that the GPA they see 
on Self-Service is “final” until they can see grades from each course that they’ve 
taken during any particular semester.   

See GPA: Gapped (Auburn Only) 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. “Next Block” into the “Current Standing” block of the form. 
1. The “Institution” line lists the GPA calculated over all courses that were 

taken at Auburn.  This calculation is a gapped calculation. 
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Notes: 

1. The number of hours the student has registered for over time 
2. The number of hours the student has passed over time 
3. The number of hours the student has earned over time (usually the same as the 

number of passed hours) 
4. The number of hours that count in the student’s GPA.  If the student has 

GAPPED any grades, this number will be lower than the attempted hours 
number. 

5. The number of quality points (4 per credit hour of “A”, etc.) the student has 
earned.   

6. The GPA:  #5 ÷ #4 

See GPA:  Within Major/Program 
In order to see a GPA of “within major” classes, a Compliance (CAPP) must be 
run.  This is done via Banner Self-Service, and will not be available until 
Spring, 2008. 

1. Log in to AU Access. 
2. Click on the Employee Services Tab. 
3. Click on the “Banner Self Service” Link. 
4. Click on the “Faculty Services” tab. 
5. Click on the “Term Selection” link. 

 
6. Select the appropriate term, then click the “Submit” button. 
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7. Click on the “Student Information” link.  

 
8. Click on the “ID Selection” link. 

 
9. Enter the desired student’s AU UserName in the “Student or Advisee ID” 

field.  Be sure to use ALL CAPS when entering this information, then 
click the “Submit” button. 
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10. Confirm that you’ve selected the correct student, then click the “Submit” 
button. 

 
11. Click on the “Degree Evaluation” link. 

 
12. Click the “Generate New Evaluation” link at the bottom of the screen. 
13. Complete the compliance process as you were taught to do in your CAPP 

training. 

See GPA:  Overall 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. “Next Block” into the “Current Standing” block of the form. 
3. The “Overall” line lists the calculated GPA for all courses that have been 

included in the GPA, including transfer work.  This is a gapped 
calculation of GPA. 

See GPA:  By Subject Area 
Note:  Seeing a GPA by subject area is NOT the same as the within major GPA.   

1. Enter “SHASUBJ” in the "Go To..." field of the main menu in Banner 
Admin. 

2. Enter the appropriate student ID in the “ID” field and the desired subject 
code (EDMD, ENGL, MATH, etc.) in the “Subject Code” field to see 
information beginning at that subject and continuing to the end in an 
alphabetical arrangement.  OR  Leave the “Subject Code” blank to see the 
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total list of subjects in alphabetical order. 

 
3. “Next Block” past the “Current Standing” block and into the “Subject 

GPA and Course Information” block of the form. 

 
4. Use the scroll bar if available in the “Subject” block or the down arrow on 

the keyboard to scroll through the available list of subjects that the 
student has taken.  Note that the attempted, passed, earned hours 
information as well as GPA information is calculated only across the 
courses that fall within a specific subject code.  Institutional (Auburn) 
courses that have been taken are listed in the “Institutional block.  
Transfer courses that have been articulated to Auburn courses are listed 
in the “Transfer” block.  Grades for the corresponding courses are 
viewable in these blocks of the SHASUBJ form.  

See GPA:  High School 
1. Enter “SOAHSCH” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
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3. “Next Block” into the “High School Details” block of the form. 

 

The HS GPA (if captured) is listed in the “GPA” field.  Note:  This is an entered 
value, that is entered at the time the application is processed during the 
admissions process.   
Please note as well that the graduate date listed on this form is the HS 
graduation date.  It is supplied by the student at the time the application is 
completed online.  It may or may not be accurate, depending on how accurate 
the student was while entering information in the online application. 

See GPA:  UnGapped 
2. Enter “SZFSHTM” in the “Go to…” field of the main menu in Banner 

Admin. 
3. Enter the desired UserName in the “ID” field. 
4. Enter the correct course level code in the “Course Level Codes by Person” 

field.  UG = Undergraduate; GR = Graduate; PR = Professional. 

 
5. “Next Block” into the “Current Standing” block of the form. 

 
Notes: 
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1. The number of hours the student has registered for over time 
2. The number of hours the student has passed over time 
3. The number of hours the student has earned over time (usually the same as the 

number of passed hours) 
4. The number of hours that count in the student’s GPA.  If the student has 

GAPPED any grades, this number will be lower than the attempted hours 
number. 

5. The number of quality points (4 per credit hour of “A”, etc.) the student has 
earned.   

6. The GPA:  #5 ÷ #4 
7. The number of hours the student has earned including any GAPPED hours. 
8. The number of hours the student has GAPPED (removed from the GPA 

calculation and GPA hours). 
9. The number of quality points the student has earned (should be the same as #5). 
10. The UNGAPPED GPA:  #9 ÷ #7 (This will likely be LOWER than the value in #6). 

See Grades (SFASLST, SHATERM, 
SHACRSE, SHASUBJ) 
There are two ways for grades to be accessed.  The first is by class roster (for all 
students enrolled in a specific class section, the next is for a specific student and 
specific term.  As always, students may see their own grades via Banner Self-
Service.  
WARNING:  Information that is found on SFASLST, SHATERM and SHACRSE is 
highly sensitive information and should be treated with the utmost confidentiality 
as per Auburn University Policy. 

See Grades – by Class Roster (Banner Admin) 
Grades for classes that were taken prior to Fall, 2007 semester are historical and 
can be found in an external report outside of Banner.  Seeing grades by class in the 
manner described below is only effective for classes offered Fall 2007 and later. 

5. Enter “SFASLST” in the “Go To…” field of the main menu in Banner 
Admin. 

6. Enter the appropriate term code and CRN in the corresponding fields. 

 
7. “Next Block” into the form. 
8. The class roster is displayed (6 names per screen).  If grades have been 

submitted for the selected course, they will appear in the “Midterm 
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Grade” and/or “Final Grade” columns.   

 

See Student Grades (Banner Admin):  
By Student ­­ All Auburn Courses Taken 
7. Enter “SHATERM” in the “Go To…” field of the main menu in Banner 

Admin. 
8. Enter the ID of the desired student. 
9. Select the appropriate “Course Level Code” from the drop down list in the 

“Course Level Codes by Person” field. 
10. Leave “Start Term” field blank.   

 
11. “Next Block” into the “Current Standing” block of the form. 
12. “Next Block” into the “Term GPA” block of the form. 
13. Use the scroll bar (if available) or the down arrow key on your keyboard 

to navigate through the terms that are available for the desired student.  
Grades are available in the “Grade” column for each class listed.   

 
Note that the institutional courses information in the “Institutional 
Courses” block change as you scroll through the available terms. 
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By Student ­ Auburn Courses by Term  
1. Enter “SHACRSE” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the ID of the desired student in the “ID” field. 
3. Enter the desired term code in the “Term” field. 
4. “Next Block” into the body of the form. 

 
Each of the columns are self explanatory, except possibly for the “Grading Mode” 
and “Repeat” columns.  For Grading Mode:  S= Standard grades (A-F); T = 
Thesis/Dissertation; P= S/U (pass/fail); N = Non-graded; A = Audit.  The “Repeat” 
field is the “Repeated Course Indicator.”  It is used to flag students course as 
repeated for inclusion or exclusion in GPA calculation.  The values you might see 
are:  (I)-include, (E)-exclude or (A)-exclude from earned hours but average into 
GPA. 

By Student – Gapped Courses  
1. Enter “SHACRSE’ in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field.  
3. Leave the “Term” field blank if you want to see a snapshot of all courses 

taken at Auburn. 
4. “Next Block” into the body of the fom. 

 

The gapped grades are listed with “X” in front of the grade.  Be sure to identify 
the term code associated with the course that has been gapped. 
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See Holds For A Student (SOAHOLD) 
There are two ways for a person to see the holds that have been placed on a 
student’s record.  The first is through direct access to the hold screen, the second 
is from the registration screen.  Students can also see their holds via Tiger i. 

WARNING:  Information that is found on SOAHOLD is highly sensitive information 
and should be treated with the utmost confidentiality as per Auburn University 
Policy. 

Seeing Holds (From Registration) 
1. Enter “SFAREGS” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Click “OK” to the SOADEST error message you see, or exit out of the 

SOADEST form that appears.  The SFAREGS form will display. 

 
3. Enter the appropriate term in the “Term” field. 
4. <TAB> to the “ID” field and enter the student’s username. 
5. <TAB> to the “Holds” field. 

 
Note:  You may use either the student’s 902 number or their username. 

6. Click the “Search” button immediately to the right of the “Holds” field. 

 
7. The holds for the student are displayed.   

 
Notes:  
The username of the person who placed the hold is indicated on this 
form. 
The holds displayed here are ONLY the holds that affect registration.  If 
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no holds are listed here, the student may still see a hold indicator in Self-
Service for holds that do not impact registration. 

Seeing Holds (From Hold Screen) 
1. Enter “SOAHOLD” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the student’s username in the “ID” field.  You may also use the 

student’s 902 Banner ID number. 
3. “Next Block” into the form. 
4. The holds for the student are displayed.  

 

Important Information Regarding Holds 
The most recently placed holds will be closer to the top of the list.  Holds have a 
“From” (the date placed) and a “To” (the last date the hold will be applied) date.  
Most “To” dates will be sometime in the year of 2099; forever, for all practical 
purposes.  Holds that have been removed from a student’s record will have a “To” 
date that matches the date that the hold was removed.  Holds are instantaneously 
applied and instantaneously removed once the record is saved.  This means that if 
a hold is placed or removed at a particular minute of the day, the action is effective 
as of that minute.  Overnight updates are not necessary for activation or removal of 
holds. 

Finding Meeting Time/Place For Class(es) 
There are two main ways to find the location and time for a particular class.  The 
easiest way to do this is to use the “Schedule Building Report” that is available to 
anyone who can log in to AU Access.  The second way is to use Banner INB to find 
the same information.  The steps for using Banner INB are located in the “See 
Room Usage…” help file. 

Finding Meeting Time/Place for specific courses: 

1. From the AU Homepage, log in to AU Access. 
2. Click on the “Employee Services” tab. 
3. Scroll down to the “Quick Links” channel. 
4. Click on the “Schedule of Courses” link. 
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5. Select the appropriate term from the “Term” dropdown menu list, 
then click the “Submit” button. 

 
6. Select at least one subject.  You can select multiple subjects by either 

<shift>+clicking (continuous list) or <ctrl>+clicking (discontinuous 
list) 

.  
7. If you want a single course, enter the course number in the “Course” 

field.  Otherwise, leave “Course” blank for all classes within a 
particular subject area. 

8. Click the “Class Search” button. 
9. The results are listed by Subject, then course number, then in CRN 

order. 

Finding Room Sizes (Capacities) 
In order to see the listed room capacities (seat limits) for classrooms, the following 
steps should be followed.  Please note, room capacities are set by the FIRE 
MARSHALL.  While departments can request that a room capacity can be lowered 
(for instance, a computer classroom has 15 computers, but has a listed capacity of 
20) quite easily, requests to increase room capacities must be approved by the 
FIRE MARSHALL prior to entry into the system.  Specific requests to change room 
capacities should be sent to Samuel Potts via an email memo from the appropriate 
person of authority (department head, associate dean, etc.). 

Finding Room Capacities 
1. Enter “SLARDEF” in the "Go To..." field of the main menu in Banner 

Admin, then strike the <ENTER> key. 
2. Enter the desired building and room number in the appropriate fields of 

the keyblock.  Leave the “Term” field blank.  
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3. “Next Block” into the body of the form. 
4. Note the seating capacity and affiliation of the room in the body of the 

form.  In the example below, the room is listed as having a maximum 
capacity of 49, and being affiliated with the EFLT department in the 
College of Education. 

 

Find A Room Usage (SSAMATX) 
Sometimes, it is important to know what classes are scheduled in specific rooms.  
This may be for special event scheduling or maintenance purposes.  In these 
circumstances, the Room Matrix form can be used to see a room’s usage schedule. 

To see a Room’s usage schedule, enter “SSAMATX” in the “Go To…” box of the 
main menu screen in Banner INB.  The resulting query form can be used in a 
variety of ways.  The simplest search is to find all classes that are scheduled into a 
particular room in a specific building.  You can also use SSAMATX to see where all 
instances of a particular class (ie. ENGL 1100) are being held.  You can also check 
the checkboxes for various days of the week to see what classes are scheduled in a 
particular room at a particular time on a specific days. 

An important feature of SSAMATX is the ability to search by TERM or by EVENT.  
Scrolling horizontally along the initial search fields will reveal a “hidden” field, 
called “TERM.”  This field will be used to display the characteristic of the room 
usage in your search results.  It can also be used to tell Banner to limit the search 
only to full term uses (classes) or events (single day or shorter than full term).  If 
you forget to tell Banner which term you’re searching within, or to only look for 
events, your results list will include ALL scheduled uses of a particular 
building/room combination, for all terms that are in Banner.  As time progresses, 
the results lists in this situation will become very large. 

Simple Room Usage Search 
1. In the “Building” field, enter the building code for the desired building.  

Remember, if you don’t know the building code, you can find a list of 
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them by clicking on the “search” button just below the “Building” field 
name. 

2. <tab> to the “Room” field and enter the desired room number.  
Remember, most rooms that had leading 0 in OASIS, have had those 0’s 
removed (Wallace 0116 is listed in Banner as Wallace 116, for example). 

3. Scroll to the right using the horizontal scroll bar.  Enter the desired term 
(for full term classes) in the “Term” field. 

 
4. “Execute” the query using either the menu, button, or keyboard options. 
5. The results are listed first by hour of the day using military time (all 8:00 

classes listed first), then by day (8:00 Monday classes are listed before 
8:00 Tuesday classes).  Courses as well as CRNs for scheduled classes 
are available for you to see in the results. 

 

Room Assignments by Class/Course 
1. In the “Subject” field, enter the desired course. 
2. In the “Course” field, enter the desired course number. 
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3. “Execute” the query using either the menu, button, or keyboard options. 
4. The results are listed first by building, then by room, then by time using 

military time, then by day. 

 

Room Usage by Day of the Week 
1. Enter the appropriate “Building” and “Room” information in those fields. 
2. Check the checkbox for the particular day of the week you’re interested 

in finding for that room. 

 
3. Enter desired term in “Term” field if needed. 
4. “Execute” the query using menu, button, or keyboard options. 
5. The results are listed first by hour in military time, then by day 

combinations. 

 

Room Usage for Non-Class Related Uses 
SSAMATX can be used to see the room usage of a specific classroom.  In some 
cases, a room will be “booked” with a CRN that begins with the letter “A” and does 
not have a corresponding subject and course number to go with it.  You may also 
see “EVENT” entered in the “Term” field, along with dates in the “Begin and End 
Dates” field that do not match the beginning and ending dates for the semester.  
These are all indications of room usages that have been scheduled outside of the 
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normal class schedule.   

 
In order to see the specific information regarding the use of rooms in this manner, 
the contact person to call is Joan Bishop.  There is also a form that can be 
accessed in order to get more specifics about these room usages. 

1. Make a note of the CRN code that is used to hold the room that is not 
attached to a specific course.  In the example above, that code is 
“A0020.” 

2. Enter “SLAEVNT” in the "Go To..." field of the main menu in Banner 
Admin, then strike the <ENTER> key. 

3. Enter the code from SSAMATX in the keyblock of the form. 

 
4. “Next Block into the body of the form. 

 
5. Note the contact information for the event in case further inquiries are 

needed. 

Extracting Room Usage Information 
The results from queries to SSAMATX are extractable.  This means that users can 
pull the information from Banner Admin and use it as external data within a 
spreadsheet program such as Microsoft Excel.  It is important to remember when 
completing this process, however, that the use of the <ctrl> key to control the 
appearance of pop-up blocking software is VITAL to the success of these 
procedures. 
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There are three main steps to extract the results of a query from SSAMATX.  First, 
run the desired query.  Be sure to indicate whether you are looking for information 
about room usage for a particular term or range of dates to ensure that you receive 
the shortest possible list.  This will help avoid confusion.  Second, extract the data 
and save it as a .csv (Comma Separated Values) file that can be read by 
spreadsheet programs.  Last, import the data into the spreadsheet file.  There are 
still users on campus who are using Excel 2003 and some who are now using 
Excel 2007.  The steps in this document assume that you are using Excel 2007.  If 
you are using Excel 2003 the steps are similar but the location of some menus for 
some procedures is slightly different.  Where possible, these differences are 
indicated in boxed text. 

The information provided in the following steps will assume that the user has 
already run a successful query for room usage.  It will continue from the second 
major step, extracting the data from the query. 

Extracting query data from Banner 
1. Once the query results are displayed, select 

“Extract Data No Key” from the “Help” menu.  Be 
sure to hold down the <ctrl> key until the dialog 
box for step 2 appears.  

 

 

 

 

 

 

 

2. Click the “Save” button on the “File Download” dialog box.  Be sure to 
hold down the <ctrl> key until the “Save As” dialog box appears.   

 
3. Give the file a new name (the provided name is not memorable). 
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4. Change the “Save In…” location to one that you will remember contains 
the file when you’re finished. 

5. Click the “Save” button.  Be sure to hold down the <ctrl> key until the 
“Download Complete” box appears. 

 
6. Click the “Close” button on the “Download Complete” dialog box. 

 

Importing data into Excel (2007) 
1. Open a new workbook in Excel 2007. 
2. Navigate to the “Data” tab. 
3. Select “From Text” on the “Get External Data” group. 

 
4. Locate the .csv file containing the extracted Banner data using the 

“Import Text File” dialog box.  Highlight the desired file. 
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5. Click the “Import” button on the “Import Text File” dialog box. 

 
6. Click the “Delimited” radio button on the first screen of the “Text 

Import Wizard” dialog box. 
7. Click the “Next” button on the first screen of the “Text Import Wizard 

screen 1 of 3” dialog box. 

 
8. Uncheck the checkbox next to “Tab” on the “Text Import Wizard 

screen 2 of 3” dialog box. 
9. Check the checkbox next to “Comma” on the “Text Import Wizard 

screen 2 of 3” dialog box. 
10. Click the “Next” button on the “Text Import Wizard Screen 2 of 3” 

dialog box. 

 
11. Click the “Finish” button on the “Text Import Wizard Screen 3 of 3” 

dialog box.  You may also elect to format your columns on this 
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screen, but it is not necessary for the success of the procedure. 

 
12. Click “OK” on the “Import Data” dialog box.  You’ll notice that one of 

the cells in the workbook is selected.  This step tells Excel where to 
begin pasting the data. 

 
13. Verify that your data has been imported.  At this point, you can 

format the spreadsheet as you desire for usability and readability.  
Notice that all data from the query was imported and is visible 
without having to scroll for screen shots or scroll horizontally in the 
window. 
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See Student Schedules (SFAREGQ) 
There are two ways to see a specific student’s schedule.  The first is in Banner 
Admin, the second is via AU Access.  Students can access their schedules via Tiger 
i. 

WARNING:  Information that is found on SFAREGQ is highly sensitive information 
and should be treated with the utmost confidentiality as per Auburn University 
Policy. 

See Student Schedule (Banner Admin) 
1. Enter “SFAREGQ” into the “Go To…” field of the main menu in Banner 

Admin. 

 
2. Enter the appropriate term in the “Term” field. 
3. Enter the appropriate student username in the “ID” field. 

 
Note, once the username is entered in the “ID” field, strike the <enter> 
key to see the student’s name fill the empty field to the right of the “ID” 
field.  The student’s 902 (Banner ID) number will replace the username. 

 
4. “Next Block” into the body of the form. 
5. The student’s schedule will display. 

 
Note the meeting days/times are indicated in these results, as well as the 
location of the class.  Blank fields indicate information that was not 
provided in the schedule of classes. 
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See Student Schedule (AU Access) 
1. From the AU Homepage, click on the “AU Access” link. 
2. Log in with your regular username and password. 
3. Scroll down to the “Quick Links” channel, then click on the “View/Print 

Student Schedules” link. 

 
4. Click on the “View Student Schedule” link. 

 
5. Select the appropriate term from the term dropdown menu, then click 

the “Submit” button. 

 
6. Enter the appropriate username in the “Student or Advisee” field.  Note:  

You MUST use all capital letters in this field if you are using usernames.  
You may also use the student’s 902 number if you know what it is. 

 
Note:  You may NOT use the “Student and Advisee Query” fields to select 
a student’s schedule this way. 
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7. Confirm that you’ve selected the intended student, then click the 
“Submit” button. 

 
8. The student’s schedule will display. 

 
Note that the semester for which the schedule is current is displayed in 
the upper right corner of the screen.  Also note the meeting time/place 
information for each course is listed on the same line as the envelope 
icon.  The envelope icons will initiate email to the listed instructor of 
record. 

See Test Scores (SOATEST) 
WARNING:  Information that is found on SOATEST is highly sensitive information 
and should be treated with the utmost confidentiality as per Auburn University 
Policy. 

See Test Scores 
6. Enter “SOATEST” in the "Go To..." field of the main menu in Banner 

Admin. 
7. Enter the desired UserName in the “ID” field. 
8. “Next Block” into the body of the form. 
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Notes:  
If the student has made their own information “confidential” the “Confidential” 
indicator is located immediately above the “ID” field in the key block of the form. 
The Test Scores (2) and Test Scores (3) tabs are not being used by Auburn. 

See Transfer Work (SHATRNS, SHATERM) 
Viewing transfer work in Banner Admin can take a little while to become 
accustomed to.  For students who are transferring work from a single institution 
the transfer work is a bit more straightforward to view.  However, there are times 
when students bring in transfer work from multiple institutions.  Additionally, 
students may have multiple “attendance periods” from each institution.  These are 
roughly equivalent to the terms that were attended at the other institution.  
However, if a student has attended a single institution for a continuous period of 
time (even if that period of time covers multiple semesters) the admissions officers 
may enter those courses under a single attendance period.  Therefore, it is 
important that when viewing transfer work, you be diligent in making sure that all 
work has been posted to the student’s record.  Please be aware, as well, that only 
work that has been provided via an official transcript from the student will be 
posted to the record.   

WARNING:  Information that is found on SHATRNS and SHATERM is highly 
sensitive information and should be treated with the utmost confidentiality as per 
Auburn University Policy. 
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See Transfer Work 
1. Enter “SHATRNS” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. Select the desired “Transfer Institution Number” from the drop down list 

provided. 
4. Select the desired “Attendance Period Number” from the drop down list 

provided. 

 
5. “Next Block” past the “Transfer Institution” and “Attendance Period” 

blocks into the “Transfer Course Detail” block of the form. 
6. Use the scroll bar (if activated) or the down arrow key on the keyboard to 

navigate through the list of courses that were taken at the transfer 
institution.   

 

There are different ways that transfer courses can be applied to a student’s 
record.  The first (pictured above) is fairly straightforward.  In this case, ENG 
101 from the transfer institution has been articulated to ENGL 1100 for the 
Auburn equivalent.  However, sometimes, coursework from other institutions 
isn’t as straightforward in interpretation.  Notice in the following illustration, 
the PEND as the articulated course in the “Equivalent Course Detail” block of 
the form. 

 
In this example, the course ORI101 from the transfer institution has been 
articulated as PEND, meaning that further analysis is needed before an 
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accurate articulation can be credited for the student.  Another example of the 
way courses are articulated is when a course from the transfer institution is 
“split” to fill more than one Auburn articulation.  Notice in the following 
illustration, the PEND for a portion of the articulated courses. 

 
In this example, the student took THR114 at the transfer institution, but only 1 
credit of it has been applied to Auburn’s THEA 2020.  The other credit is still 
listed as PEND, since further analysis is needed. 

7. “Next Block” into the “Attendance Period” block of the form. 

 

The hours the student attempted, passed, earned and applied toward the GPA 
are listed in the corresponding fields.  The GPA listed in this block is the GPA 
for the courses that were applied to this attendance period.  There is a different 
procedure for finding the GPA of all transfer work from all institutions. 

See Transfer Work: Total Transfer GPA (All Transfer 
Institutions) 

1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 
Admin. 

2. Enter the desired UserName in the “ID” field. 
3. Enter the correct “Course Level” from the drop down list provided in the 

“Course Level Codes by Person” field. 
4. Leave the “Term” field blank. 
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5. “Next Block” into the “Current Standing” block of the form. 

 

The “Transfer” information include all transfer work that has been applied to 
the student’s record. 

See Transcript Information (SHATERM) 
Only the office of the registrar has the authority to view or run official student 
transcripts.  However, advisors may need to see a list of courses taken, with 
grades, in order to provide accurate guidance to students.  That information is 
available in Banner Admin on the SHATERM form.  Students can access unofficial 
copies of their own transcripts via Banner Self-Service.   

Some units on campus may have a legitimate need to have copies of student 
transcripts run for reporting to outside agencies (eg. ROTC Units).  In these 
situations, the unit should provide the registrar’s office with a list of student 
names, userids, and a statement of release so that the registrar’s office can assist 
the unit with the acquisition of transcript printouts. 

WARNING:  Information that is found on SHATERM is highly sensitive information 
and should be treated with the utmost confidentiality as per Auburn University 
Policy. 

See Transcript Information 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. Enter the appropriate “Course Level Code” in the “Course Level Codes by 

Person field.  Use the drop down list if you are unsure which codes are 
available. 

4. Leave the “Term” field blank to have all term information available to 
you.   
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5. “Next Block” into the “Current Standing” block of the form. 

 

The student’s GPAs for institution (Auburn) and transfer coursework is 
displayed, along with the overall GPA.  Also displayed is the student’s academic 
standing. 

6. “Next Block” into the “Term GPA and Course Detail Information” block of 
the form. 

 

Information about student course work is presented on a term by term basis.  
Use the scroll bar (if activated) on the right side of the screen in the “Term GPA” 
block of the form to scroll through the list of terms.  Note: The “Institution or 
Transfer” field indicates whether the displayed work was completed at Auburn 
(I) or is Transfer work (T).  The illustration above shows work for the term 
200510 (Fall, 2006).  This student has a grade that was gapped (BIOL 1020) as 
indicated by the XD grade, and has a GPA for that term of 2.00.  The 
cumulative GPA is different because there has been transfer work applied to 
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that same term, as illustrated below.   

 
Note that in the illustration above, the same term is displayed as from above, 
which means that the courses were applied to the Fall, 2006 term.  Also note 
that the number of hours applied is 12, which when added to the 14 from 
previous, adds to the 26 that are displayed in the “Cumulative field.  The 
“Transfer Number” field indicates which transfer institution is being referenced.  
In this case, the 2nd.  If we were to keep scrolling we would find the first 
institution has been applied to another term.  The “Attendance Period” field 
indicates the period of time the students work was used for posting to the 
Auburn record.   

7. Continue scrolling until you reach the desired term of information you 
seek, or until you reach the end of the list. 

Running Reports in Banner Admin 
Various information types are not delivered by the baseline Banner product.  
Therefore, Auburn has written reports in some cases that will fill information 
needs.  These are usually similar to the reports that were found in WebFocus.  
Banner reports work the same general way, regardless of the type of information 
that is being delivered.  The following two examples illustrate how to run reports.   

Specific information regarding parameters for reports generated at Auburn will be 
provided to the users who are given access to those reports.   

Class Schedule Report (SSRSECT) 
The “Class Schedule” Report can be used to verify the schedule that is built each 
term, especially during the first three terms of hand-building that must occur with 
the transition to Banner Student System.   

Once sections have been built into the Banner system, the Class Schedule Report 
can be run.  The report can be set to run directly to a printer in your office, or it 
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can be set to print to an electronic file that can be saved on a shared network 
drive.   

Accessing the Class Schedule Report 
From the General Menu, enter “SSRSECT” in the “Go To…” field.  The Class 
Schedule Report Form will display.   

 
The general areas of this form are numbered in the graphic above.  They include: 

1 The Printer Control Field.  This field controls where the output of the 
report will be stored.  You may either have it sent directly to a printer, or 
you may save it electronically for future reference. 

2 The Parameter Values.  These values control the general appearance of 
the report.   

3 The Parameter Value Explanation Area.  This area helps explain the 
various options for each parameter value.  Of particular interest is 
whether or not a value is required for the report to run.   

Creating an Electronic Class Schedule Report 
In order to create an electronic file of the class schedule, you must first enter 
SSRSECT.  Second, you must indicate where the report will print in the “Printer” 
field of the “Printer Control” block.  You must then populate values for each of the 
parameters that are required in the “Parameter Values” block.  You are able to save 
the parameter set if you like, so that you can reuse it in the future.  Execute (run) 
the report by clicking on the “Save” icon.   

In order to see the results of the report, you must select “Review Output” from the 
“Options” menu.  Once there, you have the option of viewing the report in a new 
browser window where you can then save it to your desktop or removable storage 
media on your computer. 
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Generating Class Schedule Report 

The first step to generating a class schedule report is to enter SSRSECT from the 
General Menu.  The “Process Submission Controls” screen will appear for 
SSRSECT. 

 
“Next Block” to the “Printer Control” block of the form.  Then, enter the location 
where you would like the report results to appear.  You have a choice of “database” 
(you may type it in directly or choose it from the list after clicking on the down-
arrow), or another listed printer.  If you’d like a specific printer, it will need to 
appear on the list that you see when you click on the down-arrow next to the 
“Printer” field. 

 
“Next Block into the “Parameter Values” block of the form.  Please note that while 
eight parameters are immediately visible, there are ten on the list.  If you’d like to 
change the last two you’ll need to scroll down the list by using the scroll bar at the 
right of the screen.   

A brief description of each of the parameters follows.  Note that at the bottom of the 
visible list of parameters is a description line that tells you what sorts of values are 
acceptable for each parameter value.  It will also tell you whether that parameter is 
required for the report to run.  

Schedule Term.  Use the term code in the yyyytt (i.e. 200810) format that you used 
when creating the schedule. 

1 Part-of-term.  For Fall and Spring semesters, you can enter “1” for the 
value, for Summers you may want to select the part of term from the 
drop down list that appears when you click on the down-arrow at the top 
of the “Values” column.  You can also enter the Banner wildcard symbol: 
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%, to get all parts of a term.  If you always use %, you’ll always get all 
parts of term, and only have one symbol to remember.  Don’t forget that 
you can also use the down-arrow to select the appropriate part of term 
from the available ones on the provided list. 

2 Order.  This is the order in which the classes on the report will be 
organized.  The parameter value of “1” will yield a report that is organized 
by subject (the four-letter subject codes), and a value of “2” will yield a 
report that is organized by College, then Division, then Department.   

3 Campus.  For most instances, you will likely enter “A” for this value.  
Note that it must be a capital “A” and not lowercase.  If you have a 
different campus that you’d like to print a schedule for, you can select it 
from the list that appears when you click the down-arrow at the top of 
the “Values” column. 

4 Course Status.  If you enter % (the Banner wildcard) you will get all 
classes in your report.  You can also create a report that will display only 
active classes, inactive classes, or cancelled classes.   

5 Use Schedule Results.  This is a pre-populated value.  It is not suggested 
that you change it at this time.  It may be useful in the future if Auburn 
University elects to use an auto-scheduling program to schedule classes. 

6 Schedule Type.  This is also a pre-populated value.  The default value is 
the wildcard so that all classes (distance, lab, lecture, etc.) will appear on 
the class schedule report. 

7 Instructional Method.  This is another pre-populated field for the same 
reasons as “schedule type.” 

8 Print long Course Title.  This is a pre-populated field, with a default of 
“No.”   

9 Print Long Section title.  This is the last pre-populated field, with a 
default of “No.” 

Enter the appropriate parameter values in the “Values” column of the “Parameter 
Values” Block.  To move from one value field to the next, either use your mouse to 
click in the next field, or use the down-arrow key on your keyboard. 

A sample list of parameter values (with explanations) is illustrated below. 

 
“Next Block” into the “Submission” Block of the field.  Save the report.  

Note that at the bottom of the Banner screen you’ll see a message indicating your 
report was successfully generated.  There will be two files, one ending in .lis and 
one ending in .log.  You do not need to make a note of these file names.  You 
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should be aware that if you want to view the report, you’ll access the “.lis” file in 
the next process. 

 

Generating Class Schedule Report – Summary 

1 Enter SSRSECT. 
2 Enter the desired printer name in the “Printer” field (most people will 

likely use “database”). 
3 Enter appropriate parameter values in the “Parameter Values” block. 
4 Enter the “Submission” block and save the report.   
5 If you give the parameter set a name, you can access that set of 

parameters again in the “Process” Block of the form. 

 

Viewing Class Schedule Report 

Once you’ve successfully saved the report and gotten the confirmation message at 
the bottom of the screen, you can view the report (as long as you sent it to 
“DATABASE” in the “Printer” field) to verify that the schedule building data entry 
was accurate. 

The first step to viewing a report of the class schedule is to create the report.  The 
steps for that process are described in the above section(s).   

From the SSRSECT form, you should select “Review Output” from the “Options” 
menu.  You will be returning to the “Options” menu several times in this process, 
but the choices you will see each time will vary slightly from visit to visit.   
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The “Saved Output Review” screen  will appear.  You need to tell Banner which 
report file you’d like to view.  You can select the correct file by double-clicking on it 
from the list that appears when you click on the down-arrow after the “File Name” 
field.  You should select the “.lis” file rather than the “.log” file. 

 

 
The report of the schedule of class sections will display.  While this can be printed 
from the “File” menu, it may not format correctly for easy review and auditing 
purposes.  Therefore, you may want to “show” the document in a separate browser 
window.  This will allow you save it to a separate file and refer back to it during 
future review procedures. 

 

Showing Class Schedule Report 

Once you’ve displayed the report in the “Saved Output Review” screen, you can 
save it to a separate file for later review.   

First, while you are viewing the report in the “Saved Output Review” screen, select 
“Show Document” from the “Options” menu.   
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A confirmation window will appear asking you if you’d like to continue.  If you’ve 
accidentally selected the wrong file, click “Cancel” and repeat the “Show 
Document” step and select the correct one.  If you have selected the correct one 
(with the .lis extension), click “Yes” to continue to the next step. 

 
 

 Warning!  If you have a pop-up blocker activated on your computer, 
be sure to hold down the “Ctrl” key while you click the “Yes” button.  
Otherwise, your new browser window will not appear.  You may see 
a reminder bar at the top of your browser window, but you may not.  
It’s more straightforward to use the “Ctrl-click” method in order to 
show the file in a new browser window. 

 

A new browser window will appear that contains a formatted view of the class 
schedule report.  You can save this as a complete webpage or as a text file that you 
can review at a later date. 

 
 

" NOTE:  You may have a printed copy that is more pleasing to the eye if you 
set your printing orientation to “Landscape” rather than the default “Portrait.” 
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Scheduled Section Tally Report 
Running a “Scheduled Section Tally Report” is done in a similar manner as the 
“Class Schedule Report,” except the specifics of the report request will be slightly 
different. 

Creating an Electronic Scheduled Section Tall Report 
In order to create an electronic file of the scheduled section tally, you must first 
enter SSRTALY.  Second, you must indicate where the report will print in the 
“Printer” field of the “Printer Control” block.  You must then populate values for 
each of the parameters that are required in the “Parameter Values” block.  You are 
able to save the parameter set if you like, so that you can reuse it in the future.  
Execute (run) the report by clicking on the “Save” icon.   

In order to see the results of the report, you must select “Review Output” from the 
“Options” menu.  Once there, you have the option of viewing the report in a new 
browser window where you can then save it to your desktop or removable storage 
media on your computer. 

Generating Scheduled Class Tally Report 

The first step to generating a class schedule report is to enter SSRTALY from the 
General Menu.  The “Process Submission Controls” screen will appear for 
SSRTALY. 

 
“Next Block” to the “Printer Control” block of the form.  Then, enter the location 
where you would like the report results to appear.  You have a choice of “database” 
(you may type it in directly or choose it from the list after clicking on the down-
arrow), or another listed printer.  If you’d like a specific printer, it will need to 
appear on the list that you see when you click on the down-arrow next to the 
“Printer” field. 
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“Next Block” into the “Parameter Values” block of the form.  There are seven 
parameters on the parameter value list.   

A brief description of each of the parameters follows.  Note that at the bottom of the 
list of parameters is a description line that tells you what sorts of values are 
acceptable for each parameter value.  It will also tell you whether that parameter is 
“required,” or, must have a value entered for the report to run. 

 
“Next Block” into the “Submission” Block of the field.  Save the report.  

Note that at the bottom of the Banner screen you’ll see a message indicating your 
report was successfully generated.  There will be two files, one ending in .lis and 
one ending in .log.  You do not need to make a note of these file names.  You 
should be aware that if you want to view the report, you’ll access the “.lis” file in 
the next process. 

 

Generating Scheduled Section Tally Report – Summary 

1 Enter SSRTALY. 
2 Enter the desired printer name in the “Printer” field (most people will 

likely use “database”). 
3 Enter appropriate parameter values in the “Parameter Values” block. 
4 Enter the “Submission” block and save the report.   
5 If you give the parameter set a name, you can access that set of 

parameters again in the “Process” Block of the form as in the SSRSECT 
report. 
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Viewing a Scheduled Section Tally Report 

Once you’ve successfully saved the report and gotten the confirmation message at 
the bottom of the screen, you can view the report to verify that the schedule 
building data entry was accurate. 

The first step to viewing a report of the class schedule is to create the report.  The 
steps for that process are described in the above section(s).   

From the SSRTALY form, you should select “Review Output” from the “Options” 
menu.  You will be returning to the “Options” menu several times in this process, 
but the choices you will see each time will vary slightly from visit to visit.   

 
The “Saved Output Review” screen appears.  You need to tell Banner which report 
file you’d like to view.  You can select the correct file by double-clicking on it from 
the list that appears when you click on the down-arrow after the “File Name” field.  
You should select the “.lis” file rather than the “.log” file. 

 

 
The report of the scheduled sections tally will display.  While this can be printed 
from the “File” menu, it may not format correctly for easy review and auditing 
purposes.  Therefore, you may want to “show” the document in a separate browser 
window.  This will allow you save it to a separate file and refer back to it during 
future review procedures. 
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Showing a Scheduled Section Tally Report 

Once you’ve displayed the report in the “Saved Output Review” screen, you can 
save it to a separate file for later review.   

First, while you are viewing the report in the “Saved Output Review” screen, select 
“Show Document” from the “Options” menu.   

 
A confirmation window will appear asking you if you’d like to continue.  If you’ve 
accidentally selected the wrong file, click “Cancel” and repeat the “Show 
Document” step and select the correct one.  If you have selected the correct one 
(with the .lis extension), click “Yes” to continue to the next step. 

 
A new browser window will appear that contains a formatted view of the class 
schedule report.  You can save this as a complete web page or as a text file that 
you can review at a later date. 

 
 

" NOTE:  You may have a printed copy that is more pleasing to the eye if you 
set your printing orientation to “Landscape” rather than the default “Portrait.” 
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Preparing Banner Reports as Text Files 
Once you’ve viewed the report you have chosen in a separate browser window, you 
are ready to save it as a text file so that you can make it readable for yourself or 
someone else.  Except for the first step, this process does not take place in Banner.   

The first step in saving Banner reports as text files is to “show” the report in a 
separate browser window.  This process is described in previous sections.   

The result is a browser window that displays the report to you. 

 
At this point, you are no longer working in Banner, you are working in your web 
browser.  You are now ready to save the report in order to format it for readability 

Saving Banner Reports for Formatting 
From the “File” menu, select “Save As.”  You will then give the file a name that you 
can remember, change the file type to “Text File” and save it in a location that you 
will remember. 

Once you’ve saved the file, you are ready to use a word processor to open it for 
formatting.  The suggestions made here are for a format that seemed readable 
during the production of this document.  If you have other preferences, please feel 
free to implement them once the document is open. 

To format the text file so that it is easily readable, you’ll need to first open your 
word processor.  Then, from the “File” menu, select “Open.”  Navigate through the 
dialog box until you find the file that you saved.  You may need to tell the word 
process or to look for “all file types” if you can’t immediately see it in the proper 
folder.   

Once the document is open, you will notice that the formatting is “clunky,” it might 
not be easy to read.  Even though this is true, you should select “Save As” from the 
“File” menu.  Be sure to change the file type to “Word Document” (or whatever word 
processor you are using).  This will give you the opportunity to save the file in the 
format that your word processor likes and will allow you to continue to make 
formatting changes that aren’t applicable in files in text-only formats. 

The formatting choices made for this documentation are as follows: 
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• Page orientation = landscape 
• Font size = 8 
• Font name = Courier 

Saving Banner Reports – Step by Step 
 Within the browser window, select “Save As” from the “File” menu. 
 Change the file name to one you can remember. 
 Change the file type to “Text File .txt”. 
 Verify the location where the file will be saved 
 Click the “Save” button (See illustration below for steps 2-5) 
 

 
 
 Open your word processor (the illustrations in this document show 
Microsoft Word features). 
 From the “File” menu, select “Open.” 

 
 Find the text-only document of the report and open it.  Don’t forget 
that you might have to look for “all documents” in order to see the file name 
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of the text file you saved. 

 
 From the “File” menu, select “Save As.” 
 Give the file a name you will remember. 
 Change the file type to the word processor type you are using (Word, 
in this documentation). 
 Verify the location where the file will be saved 
 Click the “Save” button.  (See illustration below for steps 10-13). 
 

 
 
 Change the orientation of the page to “Landscape.” 
� Choose “Page Setup” from the “File” menu. 



66 Look Up Information 

� From the “Margins” tab, select “Landscape,” then click the “Save” button. 

  
 

 Verify the font name is “Courier”, change if necessary. 
� From the “Edit” menu, select “Select All” (the entire document will become 

highlighted). 
� Select “Courier” from the font name drop-down menu. 

  
 

 Change the font size to 8. 
� From the “Edit” menu, select “Select All” (the entire document will become 

highlighted). 
� Select “8” from the font size drop-down menu. 
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 From the “File” menu, select “Save” to save the changes to your 
report.  

At this point, you are ready to delete any unneeded information or to format the 
sections in your department in a specific manner that will allow you to easily find 
them within the report. 

Two illustrations are provided for your reference.  The first is what the report 
information looks like before you’ve formatted it for readability. 

 
The second is what the report looks like after you’ve followed the formatting 
directions provided here. 

 
Note that the biggest difference between the two output samples is that the second 
contains all of the information about each section on a single line and that the font 
is smaller.  If you choose to print your schedules on legal size paper rather than 
letter size, you can select a larger font size than 8 as the information will have 
more room on the paper for printing.  In trials of this setup, size 11 or 12 was the 
most effective for legal paper, depending on the length of some course titles. 

Sample Schedule Report Output 
Several samples of output are provided as illustrations for the various types of 
information that result from decision made during the schedule building process. 
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The first illustrates:  

 
1 That CRN 10007 does not have a building or room assigned.  The 

building and room fields on the “Meeting Time” block of SSASECT were 
left blank. 

2 That CRN 10093 had the meeting time left blank as well as the building 
and room left blank on the “Meeting Time” block of SSASECT. 

3 That the sections of ACCT 2110 listed here had LEC selected for the 
schedule type, and LEC selected for “Instructional Method.”   

4 Notice that the instructional method decision caused “XXXXXX” to be 
printed on the report.  This is what students will see when they search 
for information about the classes. 

 

The second sample output illustrates: 

 
1 CRN 10182 had two lines completed on the “Meeting Time” block of 

SSASECT.  One for a MWF meeting time, and one for a TR class meeting 
time. 

2 CRN 10182 had two instructors listed for the faculty assignment.   
3 CRNs 10091, 10096, and 10182 are all still listed as section 0 

 

The third sample output illustrates: 

 
CRN 10150 is an “on campus” class of FOUN 7400 while CRN 10023 is a distance 
education version of a class – FOUN 7426.  Note that the “Instructional Method” 
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field of SSASECT was correctly selected to reflect the distance education 
instruction.  Failure to properly select either DL1 (Distance Learning Internet) or 
DL2 (Distance Learning Video) for the “Instructional Method” will prevent the 
bursar’s office from collecting accurate course fees for these classes.   
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Quick Reference: 

Navigation in Banner 
Function Menu Option Keystroke Option Toolbar Button 

Next Record Record/Next Down Arrow 
 

Previous Record Record/Previous Up Arrow  

Clear or  
Delete Record 

Record/Clear or  
Record/Remove 

Shift + F6 
 

Insert Record Record/Insert F6 
 

Next Block Block/Next Ctrl + Page Down 
 

Previous Block Block/Previous Ctrl + Page Up 
 

Enter Query Query/Enter F7 
 

Execute Query Query/Execute F8 
 

Cancel Query Query/Cancel Ctrl + Q 
 

Rollback File/Rollback Shift + F7 
 

Save or Commit File/Save F10  

Next Field Field/Next Tab none 

Previous Field Field/Previous Shift + Tab none 

Exit File/Exit Ctrl + q  

Select File/Select Shift + F3 
 

Return to Calling 
Form from pop-up 
window  

Item/Duplicate F3 Return button on 
called form  
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See Academic Standing 
End of Term 
1. Enter “SHAINST” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName and term codes in the appropriate fields. 
3. “Next Block” into the “Term Header” block of the form. 

Current 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName and course level code in the appropriate 

fields.. 
3. “Next Block” into the “Current Standing” block of the form. 

Snapshot 
1. Enter “SGASTDQ” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next block” into the “Student Summary” field of the form. 

See Assigned Instructor 
Banner Admin 
1. Enter the “SSASECT” form. 
2. Enter the appropriate term and CRN in the corresponding fields. 
3. “Next Block” into the “Instructor” block. 

Public Access 
1. Log in to AU Access. 
2. Click on the “Employee Services Tab. 
3. Click on the “Schedule of Courses” link. 
4. Select the appropriate term, then click the “Submit” button. 
5. Select the desired subject(s), course, and/or instructor information, the 

click the “Class Search” button. 
6. Assigned instructors are printed to the right of the enrollment 

information for each class section. 

See the Registration Audit Trail 
1. Enter “SFASTCA” in the “Go To…” field of the main menu. 
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2. Enter the appropriate term and ID information in the corresponding 
fields. 

3. “Next Block” into the body of the form. 

See Class Rosters 
Banner Admin 
1. Enter “SFASLST” in the “Go To…” field of the main menu in Banner 

Admin. 
2. “Next Block” into the form. 

Blackboard/WebCT Toolkit 
1. From the AU H omepage, click on “Employees.” 
2. Click on the “Blackboard (or WebCT) Toolkit” link, then log in. 
3. Click on the “Class rolls/email” link. 
4. Select the appropriate term, department/interest area; course number, 

etc., then click the “Search” button. 
5. Select the desired section of the class, then click the “View Class Roll” 

button. 

Banner Self­Service (Instructors of Record Only) 
1. Log in to AU Access 
2. Click on the “Employee Services” tab. 
3. Click on the “Banner Self-Service” icon/link. 
4. Click on the “Faculty Services” tab. 
5. Click on either the “Summary Class List” OR the “Detail Class List” link. 
6. Select the appropriate term, then click the “Submit” button. 
7. Select the appropriate class from the CRN dropdown menu, then click 

the “Submit” button. 

See Contact Information 
Addresses 
1. Enter “SOADDRQ” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the body of the form. 

Phone Number(s) 
1. Enter “SPATELE” in the "Go To..." field of the main menu in Banner 

Admin. 
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2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “Telephone” tab of the form. 

Email Address(es) 
1. Enter “GOAEMAL” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “Email” tab of the form. 

See Curriculum Designation 
1. Enter “SGASTDN” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. Leave the “Term” field blank to have information related to all enrolled 

terms for that student available to you. 
4. “Next Block” into the desired tab of the form. 

See Enrollment Counts 
Banner Admin – Option 1 
1. Enter the “SSASECT” form 
2. Enter the appropriate term and CRN in the corresponding fields. 
3. “Next Block” to the “Section Details” block. 
4. Select “Section Enrollment Info” from the “Options” menu. 

Banner Admin – Option 2 
1. Enter “SSASECQ” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the desired information into the query fields. 
3. “Execute” the query. 
4. Scroll to see information for multiple sections. 

Public Access 
1. Log in to AU Access 
2. Click on the “Schedule of Courses” link. 
3. Select the appropriate term. 
4. Select the desired Subject(s), course, etc. 
5. Click the “Class Search” button. 
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Find A Person 
Find a Person ­ General 
1. Click the “search” button next to the “ID field on any form that contains 

it. 
2. Click the “Person Search” link. 
3. Enter the desired information in the appropriate fields. 
4. “Execute” the query. 

Find a Person: SOAIDNS 
1. Enter “SOAIDNS” in the "Go To..." field of the main menu in Banner 

Admin, then strike the <ENTER> key. 
2. Enter the desired information in the search fields. 
3. “Execute” the query. 
4. Use the information provided in order to select the desired Banner 902 

number. 

See GPAs 
See GPA: Transfer Work 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. “Next Block” into the “Current Standing” block of the form. 

See GPA: Gapped (Auburn Only) 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. “Next Block” into the “Current Standing” block of the form. 

See GPA:  Within Major/Program 
1. Log in to Banner Self-Service via AU Access. 
2. Click on the “Faculty Services” tab. 
3. Click on the “Term Selection” link and select the desired term. 
4. Click on the “Student Information” link and select the desired student.  

Be sure to use ALL CAPS when entering the student’s UserName. 
5. Confirm that you’ve selected the correct student. 
6. Select the “Degree Evaluation” link. 
7. Click the “Generate New Evaluation” link at the bottom of the screen. 
8. Complete the Degree Evaluation process according to the CAPP training 

you’ve already received. 
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See GPA:  Overall 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. “Next Block” into the “Current Standing” block of the form. 

See GPA:  By Subject Area 
1. Enter “SHASUBJ” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired ID and subject code information in the appropriate 

fields.  You can leave subject code blank if you wish. 
3. “Next Block” past the “Current Standing” block and into the “Subject 

GPA and Course Information” block of the form. 
4. Scroll or use the down arrow on the keyboard to see the various 

information for each specific subject code group of classes that the 
student has taken. 

See GPA:  From High School 
1. Enter “SOAHSCH” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the “High School Details” block of the form. 

See GPA:  UnGapped 
1. Enter “SZFSHTM” in the “Go to…” field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. Enter the correct course level code in the “Course Level Codes by 

Person” field.  UG = Undergraduate; GR = Graduate; PR = 
Professional. 

4. “Next Block” into the “Current Standing” block of the form. 

See Grades 
By Class Roster 
1. Enter “SFASLST” in the “Go To…” field of the main menu in Banner 

Admin. 
2. Enter the appropriate term code and CRN in the corresponding fields. 
3. “Next Block” into the form. 

By Student – All Auburn Courses Taken 
1. Enter “SHATERM” in the “Go to…” field of the main menu in Banner 

Admin. 
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2. Enter the ID of the desired student. 
3. Select the appropriate “Course Level” code. 
4. Leave “Start Term” blank. 
5. “Next Block” past the “Current Standing” block, and into the “Term GPA” 

block of the form. 
6. Scroll through the terms available to see applicable student information. 

By Student – By Term 
1. Enter “SHACRSE” in the “Go to…” field of the main menu in Banner 

Admin. 
2. Enter the desired ID and term code in the appropriate fields. 
3. “Next Block” into the body of the form. 

Seeing Holds 
Banner Admin (Option 1) 
1. Enter “SFAREGS” in the “Go To…” field of the main menu. 
2. Enter the appropriate term, and username in the corresponding fields. 
3. Click on the “Search” button to the right of the “Holds” field. 

Banner Admin (Option 2) 
1. Enter “SOAHOLD” in the “Go To…” field of the main menu. 
2. Enter the appropriate student username in the “ID” field. 
3. “Next Block” into the body of the form. 

Finding Meeting Time/Place For Class(es) 
1. Log in to AU Access. 
2. Click on the “Employee Services” tab. 
3. Click on the “Schedule of Courses” link. 
4. Select the appropriate term, then click the “Submit” button. 
5. Select the desired subject(s), Course Number, etc., then click the “Class 

Search” button. 

Finding Room Capacities 
1. Enter “SLARDEF” in the "Go To..." field of the main menu in Banner 

Admin, then strike the <ENTER> key. 
2. “Next Block” into the body of the form. 
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Finding Room Usage 
Finding Room Usage ­ SSAMATX 
1. Enter the SSAMTAX form. 
2. Enter the appropriate information in the desired fields (ie. Building and 

room; subject and course; desired term, and/or days of week). 
3. “Execute the query. 

Finding Room Usage – SLAEVNT 
1. Note the usage code for a specific event from SSAMATX 
2. Enter “SLAEVNT” in the "Go To..." field of the main menu in Banner 

Admin, then strike the <ENTER> key. 
3. Enter the code from SSAMATX into the key block of SLAEVNT 
4. “Next Block” into the body of the form. 

Extracting Room Usage Information 
Extracting query data from Banner 

1. Once the query results are displayed, select “Extract Data No Key” 
from the “Help” menu.  Be sure to hold down the <ctrl> key until the 
dialog box for step 2 appears. 

2. Click the “Save” button on the “File Download” dialog box.  Be sure to 
hold down the <ctrl> key until the “Save As” dialog box appears.   

3. Give the file a new name (the provided name is not memorable). 
4. Change the “Save In…” location to one that you will remember 

contains the file when you’re finished. 
5. Click the “Save” button.  Be sure to hold down the <ctrl> key until the 

“Download Complete” box appears. 
6. Click the “Close” button on the “Download Complete” dialog box. 

Importing data into Excel (2007) 
1. Open a new workbook in Excel 2007. 
2. Navigate to the “Data” tab. 
3. Select “From Text” from the “Get External Data” group. 
4. Locate the .csv file containing the extracted Banner data using the 

“Import Text File” dialog box.  Highlight the desired file. 
5. Click the “Import” button on the “Import Text File” dialog box. 
6. Click the “Delimited” radio button on the first screen of the “Text 

Import Wizard” dialog box. 
7. Click the “Next” button on the first screen of the “Text Import Wizard 

screen 1 of 3” dialog box. 
8. Uncheck the checkbox next to “Tab” on the “Text Import Wizard 

screen 2 of 3” dialog box. 
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9. Check the checkbox next to “Comma” on the “Text Import Wizard 
screen 2 of 3” dialog box. 

10. Click the “Next” button on the “Text Import Wizard Screen 2 of 3” 
dialog box. 

11. Click the “Finish” button on the “Text Import Wizard Screen 3 of 3” 
dialog box.  You may also elect to format your columns on this 
screen, but it is not necessary for the success of the procedure. 

12. Click “OK” on the “Import Data” dialog box.  You’ll notice that one of 
the cells in the workbook is selected.  This step tells Excel where to 
begin pasting the data. 

13. Verify that your data has been imported.   

Seeing A Student Schedule 
Banner Admin 
1. Enter “SFAREGS” in Banner Admin. 
2. Click “OK” past the error message on SOADEST, OR exit out of the 

SOADEST form. 
3. Enter the appropriate term and username in the corresponding fields. 
4. “Next Block” into the “Enrollment Information” block. 

AU Access 
1. Log in to AU Access. 
2. Click on the “View/Print Student Schedule” link. 
3. Click on the “View Student Schedule” link. 
4. Select the appropriate term. 
5. Enter the desired student’s AU username or 902 number in the “Student 

or Advisee ID” field.  
6. Confirm that you’ve selected the correct student. 
7. Click the “Submit” button. 

See Test Scores 
1. Enter “SOATEST” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
3. “Next Block” into the body of the form. 

See Transfer Work 
1. Enter “SHATRNS” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName in the “ID” field. 
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3. Select the desired “Transfer Institution Number” and “Attendance Period” 
from the drop down lists provided. 

4. “Next Block” into the “Transfer Course Detail” block of the form. 
5. “Next Block” into the “Attendance Period” block of the form to see 

transfer GPA and hours for that particular attendance period. 
6. View the GPA and hours information for all transfer work applied to the 

student’s record on the “SHATERM” form. 

See Transcript Information 
1. Enter “SHATERM” in the "Go To..." field of the main menu in Banner 

Admin. 
2. Enter the desired UserName and Course Level Code in the appropriate 

fields. 
3. “Next Block” into the “Current Standing” block of the form. 
4. “Next block into the “Term GPA and Course Detail Information” block of 

the form. 
5. Scroll through the list of term information until the needed information is 

displayed. 

Running Reports in Banner Admin (Samples) 
Generating Class Schedule Report 

1 Enter SSRSECT. 
2 Enter the desired printer name in the “Printer” field (most people will 

likely use “database”). 
3 Enter appropriate parameter values in the “Parameter Values” block. 
4 Enter the “Submission” block and save the report.   
5 If you give the parameter set a name, you can access that set of 

parameters again in the “Process” Block of the form. 

Generating Scheduled Section Tally Report 

1 Enter SSRTALY. 
2 Enter the desired printer name in the “Printer” field (most people will 

likely use “database”). 
3 Enter appropriate parameter values in the “Parameter Values” block. 
4 Enter the “Submission” block and save the report.   
5 If you give the parameter set a name, you can access that set of 

parameters again in the “Process” Block of the form as in the SSRSECT 
report. 
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Viewing Generated Reports 

1 Generate your desired report. 
2 Make a note of the report “number.”   
3 From the “Options” menu, select “Review Output” 
4 Select the .lis file to see the results of the report.  (If your report is blank, 

or looks wrong, you may want to view the .log file to see what Banner can 
tell you regarding the report generation.) 

5 If you want to print the report in a nicely formatted manner, select “Show 
Document” from the “Options” menu.  Be sure that you do not exit out of 
the “Review Output” mode before you do this. 

6 Click “Yes” when asked if you wish to continue to show a report in a 
browser. 

7 Use the browser’s file menu to print the report, or to save it in a .txt file.  
(The .txt file can then be opened by a word processor and formatted or 
culled to include only the portions that you desire.) 

Formatting Reports for Readability 

1 Create the report you desire. 
2 View the report, then show it in a browser window (Directions for these 

two steps are listed above). 
3 Save the report as a .txt file from the browser window (File, Save As). 
4 Open a word processor. 
5 Open the report you saved as a .txt file. 
6 Save the report in the word processing format. 
7 Change the page orientation to “Landscape.” 
8 Change the font (if necessary) to “Courier.” 
9 Change the font size to 8. 
10 If printing on legal paper rather than letter sized paper, the font size can 

be set as large as 12 and still yield readable results. 
11 Re-save the report so that your changes don’t disappear when you close 

the document. 

 


